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Requirements 

Requirements to run LottoWhiz  
 

 Pentium 75MHz or higher PC, running Windows NT/2000/XP/Vista/7 or newer. 

 128 MB RAM or higher. 

 50 Megabytes free hard disk space. 

 VGA display or higher (256 colors or more). 

 
Setup:  
Insert the LottoWhiz CD in your CD-ROM drive and follow the directions that appear automatically on 
your screen. 

After installation, load LottoWhiz and from the File/Open menu, open your favorite game.   
If your game is not included, check the How to create a new game section on how to create a new 
game. 

 
 

 



 4 of 32 

Introduction 

Thank you for purchasing LottoWhiz.  A lottery program so advanced and user friendly that will change 
your experience of playing lottery games forever.  Playing lottery will never be the same. 

 
Whether you’re a systematic lottery player or a beginner, you need LottoWhiz to help you efficiently play 
the lottery.  It is a unique lottery program that provides you with all the means to create and print 
wheeling systems directly onto the tickets, saving you time and headaches (unlike other lottery 
programs that do not print on tickets).  Of course you can print any numbers on the tickets whether they 
are chosen by you, generated randomly or numbers calculated by LottoWhiz based on past lottery 
results. 
  
Selecting numbers is as easy as a mouse click.  The number-panels in the program resemble the 
number-panels (boards) on your lotto tickets (bet slips).  The program provides you with charts and 
graphs that are easy to read and understand.  Almost anything in the game can be handled with the 
mouse. 
 
The program can be used virtually for any lottery game, which uses numbers from 0 to 99 or 1-100. For 
games such as the Wild Card Lotto etc., (where the bonus number is card and not a number) there is a 
workaround.  
For information on how to use those games see Workarounds for certain games. 
 
To access this help file from LottoWhiz click on the “Contents & Index” from the “Help” menu or press F1 
on the keyboard any time during the game.  In this help file you will find out how to do all of the above, 
plus how to create new games, how to modify, delete and update them and much much more... 

 

Assumptions  

This help file assumes you are familiar with the Windows 2000/NT/XP/Vista/7 interface.  For information 
about the Windows 2000/NT/XP/Vista/7 interface consult your Windows /2000/NT/XP/Vista/7 help file. 

 

Warranty Disclaimer 
Although LottoWhiz is a program that will certainly provide you with convenient tools to play the lottery in an intelligent 
way, it does not in any way guarantee that it will provide you the winning numbers. 
  

In no event is T&T Solutions Inc. liable for any incidental or consequential damages arising from the use of, or 
inability to use, this program. 
 
LottoWhiz is protected by copyright laws and unlicensed distribution of this program is against the law. 
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What is in LottoWhiz  

The LottoWhiz program consists of six main sections.  

 
1. The Analysis section displays the Analysis Chart, which contains all the Top Graphs for the game. 

It also includes analysis of numbers based on groups, even-odd, sum and frequency of numbers 
drawn. 

 Preview/Print displayed charts and grids. 
 

2. In the Performance - Combinations section you can do the following:  

 Create and print on your tickets almost any wheeling system for virtually any game. 

 Check the hits or matches of any drawing or numbers you select against the previous drawings 
stored in the database. 

 Check the percentage of hits of the draws against the Top Graphs from the Analysis chart. 

 Check & run a report of hits of combinations against previous draws stored in the database. 

 Transfer the numbers you selected to the “Drawing Maintenance” section (recommended for 
beginners) or enter the numbers directly into the database of drawings. 

 Multi-system support for lotteries that support system selection. 

 Filtering of random or whiz numbers based on groups, sums and/or odd-even. 

 Preview/Print displayed charts and grids. 
 

3. The Quick Pick Center section resembles the game ticket. Here you can select calculated numbers 
(recommended for first time users), your own numbers and/or random numbers.  You can print the 
numbers on your tickets or on a sheet. 

 

4. In the Drawing Maintenance section you can do the following:  

 Insert, modify and delete the drawings and/or dates for each game. 

 Search for drawings and/or dates. 

 Preview/Print displayed draws. 
 

5. The “3 and 4” section is for Pick 3 and Pick 4 games. Here you can create wheeling systems for 
Pick 3 & Pick 4 (box selections only), or select and print your own numbers or randomly selected 
numbers. 

 

6. In the Probability Calculator section you can calculate the following: 

 The odds for almost any lottery game, including the odds with wheeling systems. 

 The total combination of numbers (tickets) for almost any wheeling system. 
The total amount of winning tickets from the wheeling systems. 
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Combinations 

Combinations are all possible arrangements of numbers in fixed groups when the numbers are taken 
from a set of numbers that is larger than the fixed group.  The example below shows all combinations of 
7 numbers taken 6 numbers at a time.   This is also called a complete wheeling system, since any 
outcome of the 6 numbers out of the set of 7 numbers will guarantee a match of all 6 numbers with at 
least 1 group. 

 

The use of wheeling systems improves your chances of winning and maximizes your payoffs through 
multiple ticket hits.  In the example below if you hit 6 numbers out of the set of 7 numbers then you will 
have 1 ticket with 6 hits out of 6 numbers, and 6 tickets with 5 hits out of 6 numbers.  So, you can see that 
in this case every ticket is a winning ticket.  LottoWhiz includes a “Probability Calculator” that can 
calculate the amount of combinations on almost any wheeling system and the hit ratio as well. 

 

For example: Let’s say that you are playing New York Lotto. You want to play a set of 7 numbers.  Since 
you can only select 6 numbers in a panel, in order to play those 7 numbers you have to take those 7 
numbers and group them in sets of 6 numbers.  The total amount of these groups of 6 numbers when 
you choose from a set of 7 numbers is 7.  These groups are called combinations, and every combination 
means one ticket.  In other words, you are taking the combinations of 7 numbers taken 6 numbers at a 
time.  If you have a set of 8 numbers, then 8 numbers taken 6 numbers at a time are 28 combinations, 9 
numbers taken 6 numbers at a time are 84 combinations and so on. 

 

The program’s limit of combinations is 2,147,483,648. 

 

 

Example of 7 numbers taken 6 at a time: 
A set of 7 numbers: 1,5,10,15,20,25,30 
 
All groups of 6 from the set of 7: 
1:  1,5,10,15,20,25 
2:  1,5,10,15,20,30 
3:  1,5,10,15,25,30 
4:  1,5,10,20,25,30 
5:  1,5,15,20,25,30 
6:  1,10,15,20,25,30 
7:  5,10,15,20,25,30 

 
 

Right-Mouse 

click here for 

more options. 



 7 of 32 

Standard numbers (Fixed or Keyed) 

Standard numbers are the numbers that you choose to be displayed on every ticket.  Also known as fixed 
or keyed numbers. 
When you use standard numbers in a wheeling system, you create a partial wheeling system and the 
standard numbers will be displayed an each group of the wheeling system.   
 

They are very popular in Europe and even though the odds of some of their lotto games are not better 
than in the US, their success rate is much higher. 

 

To select standard numbers, simply left-click on the number panels in the “Performance - 
Combinations” section. 
 
 

Example of a system that uses 3 standard 
numbers and 5 variable numbers: 
3 standard numbers: 1,2,3 
5 variable numbers: 10,15,20,25,30 
 
  1:    1,2,3,10,15,20 
  2:    1,2,3,10,15,25 
  3:    1,2,3,10,15,30 
  4:    1,2,3,10,20,25 
  5:    1,2,3,10,20,30 
  6:    1,2,3,10,25,30 
  7:    1,2,3,15,20,25 
  8:    1,2,3,15,20,30 
  9:    1,2,3,15,25,30 
10:    1,2,3,20,25,30 
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Variable numbers 

Variables are the main numbers of the wheeling group.  In other words, they will be used to create a 
wheeling system.  If you choose only variable numbers then you can create complete (full) wheeling 
system, or an abbreviated wheeling system.  If you choose variable numbers with some standard 
numbers then you will create a partial wheeling system. 
 
To select variable numbers, simply right-click on the number-panel in the “Performance - Combinations” 
section. 
 
For example: let’s say that you play New York Lotto where you choose 6 numbers out of 51 numbers and 
you choose 10 variable numbers and no standard numbers, then 10 numbers taken 6 numbers at a time 
are 210 combinations.  If you choose 10 variable numbers and 3 standard numbers, then the 
combinations of 10 numbers taken 3 numbers at a time are 120 (It’s taken 3 at time now because the 
other 3 numbers are the standard numbers that will appear on each of the 120 panels). 
 
 

Example of a system that uses 3 standard 
numbers and 5 variable numbers: 
3 standard numbers: 1,2,3 
5 variable numbers: 10,15,20,25,30 
 
  1:    1,2,3,10,15,20 
  2:    1,2,3,10,15,25 
  3:    1,2,3,10,15,30 
  4:    1,2,3,10,20,25 
  5:    1,2,3,10,20,30 
  6:    1,2,3,10,25,30 
  7:    1,2,3,15,20,25 
  8:    1,2,3,15,20,30 
  9:    1,2,3,15,25,30 
10:    1,2,3,20,25,30 
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Wheeling systems 

Wheeling systems are the arrangement of numbers in groups which are taken from a larger group or 
set, in such a way that it will maximize the chance of winning and will also maximize the payoffs-due to 
the use of repetitive groups of numbers.  There are many varieties of wheeling systems and they are 
very popular in Europe where they are used extensively since their lotto tickets allow multiple selections 
of numbers.  Wheeling systems can be separated in to 3 categories, Complete (full) wheeling systems, 
partial wheeling systems and abbreviated wheeling systems. 

 

Complete (Full) wheeling systems are the arrangement of numbers in groups (combinations) which 
guarantee you the maximum number of hits from the wheeling group if the numbers drawn are found in 
that group.  Partial wheeling systems & Abbreviated wheeling systems do not guarantee the 
maximum number of hits but lesser hits, depending on how you create the wheeling system. 

 

Tip: 

The use of a wheeling system is highly recommended for a group of people where everybody chips in, 
like work colleagues or friends, especially when the jackpot of a lottery game is very large.  You can 
customize your wheeling system based on the amount of money collected. 

 

How to create a complete (full) wheeling system 

To create a complete wheeling system: 
 

 

1. In the “Performance - Combinations” section select the 
main set of numbers (wheeling group) for the wheeling 
system, which are the variable numbers, by right clicking on 
the number-panel. 

 

2. Click on the “Run Combinations” button or menu. 
 

 
That’s how easy it is to create a complete wheeling system using LottoWhiz.  Also known as Full 
Wheels. 
Make sure you select more numbers than what you select in that game.  For example, if it is a Pick 6 
game select more than 6 variable numbers, if it is a Pick 5 game select more than 5 variable numbers 
and so forth.   The combinations tend to increase in size drastically so do not select too many numbers.   
You can print the entire lottery’s wheeling system (which could take you weeks or months). 
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How to create a partial wheeling system 

To create a partial wheeling system: 
 

 

1. In the “Performance – Combinations” section left-click on the 
number-panel to select the standard (fixed or keyed) numbers 
and right-click to select the variable numbers.  

 

 

2. Click on the “Run Combinations” button or menu. 
 

 
That’s how easy it is to create one type of a partial wheeling system -using LottoWhiz. 
Make sure that the standard numbers you select are less than what you select in that game.  

 
For example: If it is a Pick 6 game then select less than 6 standard numbers.  If it is a Pick 5 game then 
select less than 5 standard numbers and so on.  Choose as many variable numbers you need.  The 
combinations in this case are a lot less, depending on how many standard numbers you choose, and the 
chances to win are, of course, less than the complete wheeling system.  
 
Tip: 
This system is best to use when you have a strong feeling that 1 or 2 of your favorite or lucky numbers 
will come up on the next drawing.  Make sure to choose them as standard numbers. 
You can also let LottoWhiz choose the wheeling system for you by clicking on the “Suggested Wheeling 
system” button.  The numbers are chosen based on the previous statistics of the game.  Of course, you 
can customize it to your needs if the wheeling system happens to be too large or too small. 
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How to create an abbreviated wheeling system 

Click on the “Abbreviated Wheeling Systems” tab in the “Performance - Combinations “section.  If you 
have selected any numbers in the “Performance - Combinations “ section, those numbers can be 
transferred to the “Abbreviated Wheeling Systems” section by clicking on the “Get numbers from 
Complete/Partial system” button and they will all appear as variable.  You can choose what the 
minimum number of hits the wheeling system will guarantee based on the selected winning numbers in 
the group).  Click “Run wheeling system”, and the abbreviated wheeling system will be displayed on the 
right window.  You can print the system on tickets (bet slips) or save it on a file on your hard disk.  

 
 

Note:  Make sure the name of the file includes the entire name of the game on the left side (it will be 
entered automatically if the game’s name is not on the left side of the filename). Only abbreviated system 
files that have the current game’s name on the left side can be opened. 

 

 

If you right-mouse click on the combinations window (the window on right), a pop-up 
menu will be displayed with more options.  

 

Print Displayed Numbers: This option allows you to print the displayed system on paper 
or on tickets 
Print Numbers From File: This option allows you to print numbers from a file on paper or 
on tickets (see section: Printing tickets from a file) 
Check Hits/Winning Numbers…: This allows you to check numbers against the displayed 
wheeling system (see section: How to check winning numbers against wheel systems) 
Filter Numbers… option: You can filter out numbers after the combinations have been 
generated.  
Powerball Options…:  Use this to fill in the “B” (bonus) column as your combinations are 
generated.  
Get Numbers From …: Use this to set the number-panel with numbers from existing 
draws, current grid or from the Top Graphs Chart.  
Clipboard Functions…: This allows you to copy selected numbers into the windows 
clipboard or paste systems from the windows clipboard. 
Replace Numbers…: This option allows you to substitute your own numbers in the 
wheeling systems. This is great when importing 3

rd
 party wheeling systems. 

Print Grid: This will print the numbers that are on the grid.  
Numbers Used: This will set the number-panel with all the distinct numbers used in the 
system. This is useful when a system has been imported.   

Export to *.CSV and Launch App: This option allows the export of the numbers into a 

csv file and  will load corresponding editor which is typically Microsoft® Excel 
Clear All Numbers: This will clear the grid. 
P 
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Multi-System Support 

 
LottoWhiz includes system support for lotteries that support system selections **.  

 

Click on the “Multi-Systems Selection” button in the “Performance - Combinations “ section.  You can 
choose the amount of numbers for the system and how many to generate. Click “Random” for randomly 
generated systems or click “Whiz System” for calculated generate systems based on the previous 
outcome of drawings.  The system selection will be displayed on the right window.  You can print the 
systems directly onto the lottery tickets (bet slips) or just print them on a sheet of paper.  
If you need to enable the filtering of numbers as they being generated, click on the appropriated checkbox 
and enter the desired range or values. 

 
 
** These numbers are not wheeled, but can be used for lotteries with built in wheels. Most international 
(Non-US) lottery tickets support system selections.  If you do not know what that means we’ll use an 
example for a Pick 6 game were you can only select 6 numbers and you want to play 8 numbers taken 6 
at a time. In most US lotteries, you have to write on the lottery tickets all combinations of 8 numbers 
taken 6 at a time, which are 28 combinations.  In the lotteries that support the system selection you can 
select 8 numbers right on the lottery ticket. (Of course the price is 28 times the price of 1 combination).  
Some lotteries support systems up to 20 numbers or more. 

 

 

Right-Mouse 

here for more 

options 
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Performance Graph 

In the performance graph you can see the matches (hits) of the numbers you have picked (Standard 
and/or Variable) against the database of drawings. 

 

Hits Against Top Graphs 

This chart shows if there are any hits (matches) of the numbers you have picked against all Top Graphs 
from the “Analysis” section.  You can also check the new drawings here - before you insert them in the 
database.  The hits can be viewed as a pie chart or as a bar graph. 
 
*Only up to the amount of numbers drawn in a game can be checked here. 
 

 
Tip: You can print the displayed graph by clicking on the “Print Graph” button or menu. 
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Analysis Chart 
This Chart shows all major Top Graphs. 

 

 Histogram - tells us how many times a number has been drawn. 

 Overdue Histogram - shows us how many drawings have elapsed since a number was last drawn. 

 Top Hot Numbers - are the top most frequently drawn numbers. 

 Top Cold Numbers - are the top least frequently drawn numbers. 

 Top Due Numbers - are the top numbers with the longest elapsed period since they were last drawn. 

 Top Periodic Frequency - a graph displays the top numbers that are due to come up because of 
their tendency to reoccur in a periodic manner. 

 Top Periodic Pattern - a graph displaying the top numbers that are due to come up not only because 
of their tendency to reoccur in a periodic manner but because they also have a tendency to reoccur 
with a pattern. 

 Top Pairs - are the top most often drawn pairs. 

 Top Triples - are the top most often drawn triples. 

 Top Predictions - are the numbers that are most likely to come up, based on the statistical analysis 
of all the other graphs. 

 Statistical Hits From Top Graphs - a pie chart that displays the percentage of numbers drawn 
from the top graphs. 

 

All the graphs above are calculated based on the drawings recorded in the database.  Therefore, if the 
database is very small there may be less than the numbers indicated in any of the top graphs. 

 
 
Tip: 
a). You can print the displayed graph by clicking on the “Print Graph” button or menu. 
b).  When viewing the Top Pairs/Triples on the Top Number Sets form, you can change the “Numbers in 
Set” value to 4 or higher to view the Top Quads/Quintuplets/etc., 

 
 
Thorough Statistical Analysis 
When running this analysis the Top Prediction graph re-adjusts itself to the new percentage of hits from 
graphs of the drawings entered since it was last run. 
 

You can run this analysis as often as you like.  It’s recommended that you should run it at least once on 
every third drawing entered in the database. 
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Quick Pick Center 

The Quick Pick Center (formerly known as Printing Center) section resembles the game ticket and is 
actually a quick pick section.  Here you can select calculated numbers (recommended for first time users), 
your own numbers and/or random numbers.  You can print the numbers on your tickets or on a sheet of 
paper. 
 
To select the calculated numbers simply click on the “Calculated numbers” button or menu.  The 
numbers are taken from the “Suggested Wheeling system” from the “Performance - Combinations” 
section and are displayed in increments of the whole game ticket at a time as you’re clicking the 
“Calculated numbers” button.  You can print your tickets or the numbers at any time.  You can clear the 
calculated numbers by clicking on the “Clear” button or menu. 
 
Selecting your own numbers is done in exactly the same way you select the numbers from a real game 
ticket but instead of marking them with a pen, here you simply click, on the numbers you like on the 
number-panel with your mouse.  You can select only as many numbers per number-panel as you are 
allowed to select in the game you’re playing.  And every number-panel in this section has a “Clear” and a 
“Quick” button to customize individual number-panels at your request. 
 
To randomly select numbers, simply click on the “Random numbers” button or menu.  
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About number-panels 

 

 

The purpose of the number-panels is to help you select the 
numbers you need for the game.  The numbers selected can be 
checked, searched for, used in a wheeling system, or be entered in 
the database, all through these number-panels. 
 
The number-panel in the “Performance – Combinations “ section 
allows you to select standard numbers - by left clicking, or variable 
numbers - by right clicking, to be used in a wheeling system.  You 
can check the numbers you select against the database of previous 
drawings or against the Top Graphs.  You can also insert the 
numbers directly into the database.  Until you become familiar with 
the great features of this program, it is recommended that you 
transfer them to the number-panel of the “Drawing Maintenance“ 
section and then enter them in the database. 
 

 
The number-panels in the “Quick Pick Center” section resemble the game ticket.  Here you can select 
calculated numbers (recommended for first time users), your own numbers and/or random numbers.  You 
can only left-click on them, and every number-panel here has a “Clear” and a “Quick” button to 
customize individual number-panels at your request. 
 
The number-panel in the “Drawing Maintenance“ is used for selecting numbers to be entered in the 
database or to be searched.  In other words, you select the numbers that are drawn (by left-clicking only).  
Only if a game has a bonus (supplementary) number, then you are allowed to right-click and select it 
before you can enter the drawings in the database. 
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How to enter drawings in the database 

Entering drawings in the database is very simple.  

 

           Or                           

 

Before you can enter a drawing into the database, you must select the numbers drawn. 

Simply choose all numbers from the number-panel including the bonus numbers if any.  When all 
numbers drawn are selected then the appropriate buttons will be enabled.  

Click “Insert Drawing in the Database“ from the toolbar or from the “Drawing Maintenance“ menu.  

 

For consistency and to avoid any incorrect entries, you will not be able to insert the drawings unless all 
numbers to be entered in the database are selected.  The date will be calculated and entered 
automatically based on the last drawing in the database.  You can also insert the date and numbers you 
selected by clicking on the “Insert date & numbers” button or menu.  

   

If for any reason the date entered is not correct, then simply select the correct date from the calendar 
and choose “Insert date“ from the toolbar or the “Drawing Maintenance“ menu.  The date always gets 
entered on the selected row.  Therefore before entering the date, make sure that the drawing or the row 
on which you wish to change the date is selected. 

How to enter dates into the database 

Entering dates in the database is easy.  

 
Simply select the correct date from the calendar in the “Drawing Maintenance“ section and choose 
“Insert date“ from the toolbar or the “Drawing Maintenance“ menu.  The date always gets entered on 
the selected row.  Therefore before entering the date make sure that the drawing on which you wish to 
change the date is selected. 

 

You can not enter the same date twice.  If the drawing on that date is incorrect then select the drawing 
row and choose “Insert numbers” from the toolbar or the menu.  The program automatically sorts the 
drawings by date.  If, by accident, a drawing with no date is inserted, then go to the first drawing to find 
it and update it. 
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How to modify a bonus (supplementary) number 

 

1. Right-click on the number-panel in the “Drawing Maintenance“ section to select the bonus 
(supplementary) numbers. 

2. Choose “Insert Bonus Number(s) “.  

 

The bonus number(s) always gets entered on the selected row.  Therefore, before entering the bonus 
number, make sure that the drawing on which you wish to change the bonus number is selected. 

 

 

How to modify an existing drawing in the database 

Modifying an existing drawing in the database is simple.  

 

Simply select the correct numbers from the number-panel in the “Drawing Maintenance“ section and 
choose “Insert numbers“ from the toolbar or the “Drawing Maintenance“ menu.  The numbers always 
get entered on the selected row.  Therefore, before entering the numbers make sure that the drawing 
that you wish to change is selected. 

 

To modify an existing date in the database, see – How to enter dates into the database. 

 

For consistency and to avoid any incorrect entries, you will not be able to insert the drawings unless all 
numbers to be entered in the database are selected.  Even if all you need to change is one number, you 
must still select all numbers from the number-panel. 

 

 

How to delete a drawing 

To delete a drawing from the database: 
 

1. Select the drawing by clicking on it. 
2. Click on the “Delete” button and click “Yes” on the confirmation box. 

 

When you delete a drawing, the row (date & draw) you select gets deleted.  If you want to modify an 
existing drawing but not the date, see – How to modify an existing drawing in the database. 
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How to create a new game 

To create a new game, choose “New” from the “File” menu. A window will pop up asking you to enter a 
name for the game.  Enter a unique name for the game, up to 35 characters long. 
 
In the “Highest number in a number-panel” enter the highest number drawn in the game.  For example: 
New York Lotto is 59, New Jersey Pick 6 is 49. 
 
In the “Lowest number in a number-panel” enter the lowest number drawn in the game.   
For example:New York Lotto is 1. 
 
In the “Numbers you select from a number-panel” enter the maximum number that can be selected 
from a board (number-panel) on the lottery ticket.  
For example: In New York Lotto you select 6 numbers. 
 
In the “Numbers drawn” enter the amount of the main numbers that are drawn in the game, do not 
include the bonus (supplementary) numbers.  
For example:  In New Jersey Pick 6 it is 6 numbers drawn.  In New York Lotto it is 6 plus the 
supplementary.  In New York Pick 10 it is 20.  In New York Lotto you would enter 6 and 1 at the “Amount 
of bonus numbers” choice, the same goes for any game that has a supplementary (bonus) number. 
 
In the “Amount of bonus numbers” enter the amount of bonus number(s) drawn. 
 
In the “Amount of number-panels in a ticket” enter the amount of boards (number-panels) on a ticket 
sheet (bet slip).  
For example: New Jersey Pick 6 has 5 panels on a ticket, New York Lotto has 10. 
 
In the “Rows of number-panels in a ticket” enter the amount of rows of boards (number-panels) on a 
ticket.  
For example: New Jersey Pick 6 has 1 row of number-panels, New York Lotto has 2 rows.  
 
In the “Columns in a number-panel” enter the number of columns in a board (number-panel). 
For example: Each panel on a New Jersey Pick 6 ticket has 5 columns.  On a New York Lotto ticket each 
panel has 10 columns. 
 
In the “Rows in a number-panel” enter the number of rows in a number-panel.  
For example:  Each panel on a New Jersey Pick 6 ticket has 10 columns.  On a New York Lotto ticket 
each panel has 6 rows. 
 
At the “First number starts at column number” enter the number of the column where the first number 
of the game starts.  Most of the times it starts at column number 1 but there are a few lottery games 
where the first number starts at the 4

th
 or 6

th 
column. 

 
At the “Numbers go from top to bottom” check this box only if the numbers on the bet-slip increase 
from top to bottom instead of left to right.  Applies to bet-slip printing only.   
 
At the “First number starts at row number” enter the number of the row where the first number of the 
game starts, if the numbers go from top to bottom. Applies to bet-slip printing only.   
Note: You will not see any difference on the visual screen in the program, where the numbers will still 
show a left to right order no matter what you might have indicated. 
 
At the “Select Drawing Dates” options, select the date(s) on which the game is drawn.   
For example: New York Lotto is drawn on every Wednesday and Saturday. 
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How to delete a game 

To delete a game: 
 

1. Select “Delete Game” from the “File” menu.  
2. Double-click on the game you want to delete. 
3. Click “Yes” on the confirmation box.   

  
If you delete the current game, it will be unloaded from the program and the game with which you last 
started the program will be automatically loaded.  If the “Save Settings on Exit” option is not checked 
then you would have to open another game. 

 

How to update a game 

To update the current loaded game – choose “Properties” from the “File” menu: 

Or, 
1. Click on “Update Game” from the “File” menu. 
2. Double-click on the game you want to update. 
 

A window will pop up with the name of the game dimmed. 
Make the necessary changes and click “OK”. 
 
Updating a game is necessary when any of the game parameters change.  A good example is the 
change of the drawing date(s) or the layout and/or the number of the number-panels.   

 

If any other major changes take place, such as the amount of numbers that are drawn and/or numbers 
you select or the highest number in the game etc., then you must create a new game with the new 
parameters. This way you start a fresh game from the beginning, because these changes do change the 
odds of the game, which no longer is the same game, and the previous drawings and/or statistics no 
longer apply.   

 

How to rename a game 

To rename a game: 
 
1. Click on “Rename Game” from the “File” menu. 
2. Double-click on the game you want to rename. 
3. In the New Name box enter the new name for the game and click “OK”. 
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How to search for a drawing 

 

 
In the “Drawing Maintenance” section, select the numbers from the n that you wish to search for and 
click on the “Most Recent Match” on the toolbar or the  “Drawing Maintenance” menu.  This will bring 
you to the most recent drawing with the most matches, if any. 
 
 

If you click on the “Find All Matches” button it will go through all the drawings and stop on every 
drawing that meets the criteria of matches you have set in the “Search Options” from the “Drawing 
Maintenance” menu. 

 

 
 

How to search for a date 

 

To search for a date in the database, select the date from the calendar in the “Drawing Maintenance” 
section and click on the “Find Date” button or menu.  If your date does not exist in the database, it will 
bring you to the closest date.  

 

How to check winning numbers against wheel systems 

To check winning numbers against a wheeling system, do the following: 
 

In the “Performance-Combinations” or in the “Abbreviated Wheeling Systems”, if you already have 
created a wheeling system, either double-click on the window where the combinations are displayed or go 
to the “Hits Against Combination” section.  Any numbers entered on this number-panel will be checked 
against the combinations displayed and the graph will show the number of hits 
To check the winning numbers in the “Multi system”, section simply right-click on the window where the 
numbers are displayed and from the pop-up menu select the “Check numbers” option. 
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How to print tickets 

It is suggested that you do some printing tests before you start printing the tickets you want to play.  
Although LottoWhiz has some default values to help you print the tickets, the program will not let you print 
unless you have done a printing test and have saved the proper values for each game.   
 

 
To print your tickets: 
If you have selected a wheeling system from the “Performance - Combinations” section or have 
selected any type of numbers from the “Quick Pick Center” section, click on the “Print Tickets” button or 
menu. 
 
If you have never done a print test for the current game, the “Ticket Printing Properties” window will 
pop-up (you can select it from the “File” menu anytime you wish during the game).  You must then do a 
printing test to make sure that everything is aligned properly.  Insert your ticket into the printer and 
perform a print test by clicking on the “Print Test” button.  Make sure to insert the ticket vertically with the 
first panel down (into the printer) and the lowest number of the number-panel at the lower right corner.  If 
the marks of the printer do not align with the numbers or boxes of the boards on your tickets, you then 
have to change the values of the  “Top Margin” and/or ”Left Margin”.  Increase or decrease the margin 
values accordingly until the top left mark of the printer aligns with the top left number-box of the ticket.   
 
If the margins are aligned correctly and the rest of the printer marks still do not correctly align, then you 
can proceed and use the appropriate values for the distances, widths and heights of the boxes to correct 
the alignment of the printer-marks.  As you bring the mouse-cursor over the boxes with the values, 
information is displayed on the information box.  The window on the left displays the layout of the ticket 
according to the values on the right and changes as you change the values.  This will help you better 
understand the effects of the new values as you enter them, before you even do a printing test.  You may 
have to do a few printing tests before you get everything correct.  Once this is done make sure to save 
the values before you choose ”OK”.  From here on, you are all set for the current game and will never 
have to do anything unless new tickets come out with a different layout for the game. 
 
Note: 
If a lottery ticket has multiple rows of number-panels, then those rows have to be aligned with the top row 
of the number-panels, otherwise you will not be able to print on the other rows of number-panels. 
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Printing tickets from a file 

To print from a file that was not created by LottoWhiz; the following criteria have to be met: 
 

 The file must be a text-type file.  

 The numbers in the file have to be in a comma-delimited format and one set of numbers per line.  
For example: If you have a file with 5 sets of numbers for New York Lotto they have to be in the following 
order. 
 

#,#,#,#,#,#  
#,#,#,#,#,# 
#,#,#,#,#,# 
#,#,#,#,#,# 
#,#,#,#,#,# 
.... and so on.  
 

In the “Abbreviated Wheeling Systems” section select “Import Numbers From File” from the menu 
select your file and click “Open”.  This will import and rename the file to a proper format that can be used 
with LottoWhiz.  After a successful import, you can open it from the “Open” button. 

 
Note:  
If your file was named MyNumbers.txt and had numbers meant for New York Lotto, then after the import, 
your file will be renamed “New York Lotto MyNumbers.lwz”.  Also before importing make sure that the 
current game that is loaded is the correct game, in this case New York Lotto.  
 
Once opened, you should see the numbers appear on the right window.  
To print, right-click on that window and choose the proper action from the pop-up menu. (Choose "Print 
Displayed Numbers" - "On Tickets", or choose "Print Numbers From File" - "On Tickets" - "New York Lotto 
MYNumbers.LWZ")  
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Probability Calculator 
The Probability Calculator is a great tool to calculate the odds and the combinations of almost any 
wheeling system. 

 
To calculate the odds of a game or a complete wheeling system: 
 
All you have to do to enter a number in the boxes is to click on them.  A number-panel will pop-up from 
which you can select the numbers.  You must start entering the numbers in the following order. 
 

1. In the “N” box, enter the maximum numbers on a board in a game.  
For example: In New York Lotto there are 51 numbers. 
 

2. In the “R” box, enter the numbers you select from a board.  For example, in New York Lotto you 
select 6 numbers from each board. 

 
3. In the “A” box, enter the numbers that are drawn or enter the amount of numbers you wish to play 

for a complete wheeling system.  Do not include the supplementary number, if any  
For example: In New York Lotto there are 6 numbers drawn (supplementary is not included). 

 
4. In the “B” box, enter the number of hits you wish to have.   

 
Every possible calculation takes place as you exit the box in which you recently entered a number.  You 
can click on the toolbar buttons if you are not sure what calculation took place. 
Now click the “Probability” button on the toolbar or the menu, and everything will be displayed on the 
page.  
 
To calculate the odds of a game or a partial wheeling system: 

 

If steps 1-4 are complete then: 

 

5. In the “S” box enter the amount of standard numbers that you wish to play. 

6. In the “V” box enter the amount of v numbers that you wish to play. 

 

Now click the “Probability with Standard Numbers” on the toolbar or the menu. 
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Workarounds on certain games 

Powerball/Mega Millions:  If there is a drawing where the bonus number is drawn from the original 5 
numbers you will be able to select it twice (as a bonus number and as a standard number) in the 
“Drawing Maintenance” section only. Printing on tickets (bet slips) works fine for the main numbers 
and the bonus number. Provided you have set the bonus number printing correctly (a separated defined 
game) and have linked the main game to its bonus game. 

 

Wild Card Lotto: In this game the bonus number is a card.  Since the program’s number-panels only 
provide numbers and not letters, you select the main numbers in the usual way by clicking on them.  For 
the bonus number you select a temporary dummy number (by right clicking on the number-panel) then 
enter the drawing in the database. Once entered, go to the displayed window of drawings and double-
click on the bonus column.  A number-panel that includes card numbers will pop-up.  Select the proper 
card number and then click the “Insert” button.  Make sure to uncheck the “Include the bonus 
number” in the “Search Options” when searching for a drawing in the database.  Printing on tickets 
(bet slips) works fine for the 6 selections out of 38 numbers, except for the bonus number.  The bonus 
number will have to be filled in manually. 

 

Powerball/Mega Millions game: 

Printing on tickets (bet slips) works fine for the 5 selections out of 49 numbers except for the bonus 
number. The Powerball number (Bonus or Gold Ball number) is actually a game by itself and we 
recommend that you handle it separately to get the best possible number.  However once you have 
defined the printing parameters of the bonus number, any bonus numbers selected in the main 
(Powerball/Mega Millions) game will be printed to the play slip as well, along with the main selected 
numbers. Provided you have linked the main game to its bonus game. 

 

Powerball Number/Mega Million Gold Ball printing. 
Printing support for the Powerball games is already included with LottoWhiz  and it’s named “Powerball 
Number Printing” and “Mega Million Gold Ball” respectively.  Just open the “Powerball Number 
Printing/Mega Million Gold Ball” game and treat it as if it were another game.  If the Powerball number 
printing of your lottery is not included, then read the following on how to set it up. 

 

Setting up a new game for the Powerball number/Mega Million Gold Ball (Bonus part).  

If you would like to print the Powerball number (bonus) that is not included in LottoWhiz on a lotto ticket, 
you will have to create a new game and give it a specific name, e.g. Powerball Printing.  Use only the 
parameters that apply to the Powerball number.   

For example: The Powerball part of the game has 1 as the lowest number and 42 as the highest 
number.  In this game, enter 1 for numbers drawn and 1 for numbers you select from a panel since you 
will be dealing only with the Powerball number.  Enter 0 for the bonus number.  Then enter all the 
parameters that apply to the Powerball section of the lottery ticket, which has 1 row of 5 number-panels 
and each number-panel has 6 rows and 7 columns of numbers.   

After printing all the main numbers from the main game, you can switch to the Powerball part of the game 
by opening the newly created game and print the Powerball number on the tickets.  Of course you will 
have to set up the ticket printing properties for the Powerball.   
Once you are set with this game, open the Main Game and go to the “Properties” and “Link” it to the 
currently created game.  The Bonus number will have to be defined as a “Powerball” type number. 
 
Tip: 
You could use this part of the game for calculating all the statistics and trends regarding the Powerball 
number. 
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Technical support 
For the time being we offer technical support either by email/mail or by fax: 

Visit the frequently asked questions section on our website www.LottoWhiz.com.  If what you’re looking 
for is not there, you can e-mail at Support@LottoWhiz.com for registered users only. 

 

Mailing address:  T&T  

               12 Carpenter Pl 

Cranford, NJ 07016 

 

Voice: (201) 939-4559 

 

 

You can also send your comments to Comments@LottoWhiz.com.  We’d like to know your opinion. 

 

Please report any problems or errors to develop@lottowhiz.com.   

 

Note: 

If you think that printing or any other option is not supported for your favorite lottery game, please send 
us by mail or by fax, an actual lotto coupon and explain what you think is not working.  We will be happy 
to make it work for you, if possible. 

 

www.LottoWhiz.com
Support@LottoWhiz.com
mailto:Comments@LottoWhiz.com
mailto:develop@lottowhiz.com
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Order Form 

T&T  
12 Carpenter Pl 

Cranford, NJ 07016 
Voice: (201) 939-4559     

Email: Order@LottoWhiz.com   Web site: www.LottoWhiz.com 

Shipping Address Billing Address 

Name: 
                            

Name: 
                            

Address 
                            

Address 
                            

City 
                            

City 
                            

State & 
Zip                             

State & 
Zip                             

Country 
                            

Country 
                            

Phone 
                            

Phone 
                            

Mobile 
 

Mobile 
 

Fax 
                            

Fax 
                            

Email 
                            

Email 
                            

Web Page 
                            

Web Page 
                            

LottoWhiz    $29.95 
plus shipping * (and 6% tax in New Jersey only). 

Check one:              CD ROM                         Unlock registration code  

Tell us how you found out about LottoWhiz: 

Payment Method - Check one below: 

Check or Money order   (prepaid US funds drawn on US bank, payable to T&T).  Product will be 
shipped when payment is received. 

Visa  MasterCard  Discover  American Express  
Will be shipped on the next 
business day. 

Full Name on Card 
                                                     

Card Number 
                                                     

Expiration Date 
                                                                              CVV: 

Signature 
                                                                              Date:                

*Shipping and handling costs for the CD are $20.00. 
 No shipping charges if you are ordering the unlock registration code to be sent to you via email. 

 
 

mailto:Order@LottoWhiz.com
http://www.lottowhiz.com/
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Terminology 

Histogram  

The Histogram tells us how many times a number has come up since the beginning of the recorded 
drawings. 

Overdue Histogram 

The Overdue Histogram tells us how many drawings have elapsed since a number was last drawn.   

Top Hot Numbers 

These are the most frequently drawn numbers. 

Top Cold Numbers 

These are the least frequently drawn numbers. 

Top Due Numbers 

These are the numbers with the longest elapsed period since they were last drawn. 

Top Periodic Frequency 

The Periodic Frequency shows the tendency of numbers to reoccur after a certain period of draws.  If the 
database of draws is not large enough, there might be less than the indicated numbers in this graph. 

Top Periodic Pattern 

These are the numbers that not only have a tendency to reoccur after a certain period of draws but also 
have a tendency to reoccur with a pattern. 

Top Predictions 

The Predictions are numbers that the analysis predicts are most likely to come up based on all other 
graphs.  If the database of draws is not very large, there might be less than the numbers indicated in this 
graph. 

Top Pairs 

These are the most often drawn pairs.  If the database of draws is not very large, there might be less than 
the number of Pairs indicated in this graph. 

Top Triples 

These are the most often drawn triples.  If the database of draws is not very large, there might be less 
than the number of triples indicated in this graph. 
 
Tip: 

Searching for the Top Triples in the database will take some time.  Therefore, you can stop the search 
and continue at a later time or day provided you have not updated the database of drawings since the 
last time you stopped the search of the triples. 

You can reset the triples to start fresh, at any time by clicking the “Reset (Pairs-Triples)” and then the 
“Triples” menu-item in the “Analysis” menu. 

 

Statistical Hits From Top Graphs 

This is a pie chart that displays the percentage of numbers drawn from the top graphs. 
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Wheeling systems 

Wheeling systems are the arrangement of numbers in groups, which are taken from a larger group or 
set, in such a way that will maximize the chance of winning and will also maximize the payoffs due to the 
use of repetitive groups of numbers.  There are many varieties of wheeling systems and they are very 
popular in Europe where they are being used extensively since their lotto tickets allow multiple 
selections of numbers.  Wheeling systems can be separated in to 3 categories, Complete (full) wheeling 
systems, partial wheeling systems and abbreviated wheeling systems. 

 
 

Complete (full) wheeling systems 

Complete (full) wheeling systems are the arrangement of numbers in groups (combinations), which 
guarantee the maximum number of hits from the wheeling group if the numbers drawn are found in that 
group. 

 

 

Partial wheeling systems 

Partial wheeling systems are the arrangement of numbers in groups (combinations) which do not 
guarantee the maximum number of hits from the wheeling group but lesser hits, depending on how you 
create your partial wheeling system. 

 

 

Abbreviated wheeling systems 

Abbreviated wheeling systems do not guarantee the maximum number of hits but lesser hits, 
provided all numbers drawn are found in the wheeling system’s group. 

 

 
 
Calculated numbers 
The Calculated numbers are the numbers that are statistically chosen by LottoWhiz based on the 
outcome behavior of previous drawings stored in the database. 

 

 

Creating box wheeling systems for Pick 3 & Pick 4 

To create a wheeling system (complete for box selections only), select the numbers from the wheeling 
group and then click on the “Wheeling system for 3“ for a pick 3 game, or click on the “Wheeling 
system for 4“ for a pick 4 game.  The wheeling system will be displayed in the proper window. 
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Number-panels 

 

The number-panels resemble the real number-panels (boards) on a 
lotto ticket (bet slip).  You select the numbers in exactly the same way 
you would from a real ticket but instead of marking them with a pen, 
you click on them with your mouse. 

 

 

 

 

Checking numbers against the database 

The Performance Chart shows you the matches (hits) of the numbers you have picked (Standard 
and/or Variable) against the database of drawings. 

 

 

Checking numbers against the Top Graphs 

The Hits From Top Graphs Chart shows you if there are any hits (matches) of the numbers* you have 
picked against all Top Graphs from the “Analysis” section.  You can also check the new drawings here, 
before you insert them in the database. 
 
*Up to the amount of numbers drawn in a game can be checked here. 
For example: In New York Pick 10, you select 10 numbers but 20 numbers are drawn. 
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Example of Top Periodic Frequency Numbers 

Let's say that we have a database of 50 drawings and that the numbers 10 and 20 were drawn 15 and 12 
times respectively in the last 50 drawings in the following manner.  
 
#10:  1,3,5,2,3,4,2,3,4,5,3,7,3,3,2.   
#20:  3,1,4,1,4,5,4,4,6,2,4,3 
These numbers mean that number 10 was drawn on the first drawing and then 3 drawings later then 5 
drawings later and so on.  Number 20 was drawn on the third drawing and then 1 drawing later and then 
4 drawings later and so on.  
 
We can clearly see that the periodic frequency of number 10 is 3, because it was drawn 6 times 3 
drawings later after its last appearance.  For the same reason the periodic frequency of number 20 is 4 (5 
times 4 drawings later).  In other words if number 10 is drawn, then it has a tendency to show up 3 draws 
later and if number 20 is drawn then it has a tendency to show up 4 draws later.   

 

If the next drawing were the third drawing since number 10 was last drawn and the fourth drawing since 
number 20 was last drawn, then they would appear on the Top Periodic Frequency graph.  Provided that 
the frequency of numbers 10 and 20, which are 6 and 5 respectively, are among the Top numbers. 

  
 

Example of Top Periodic Pattern Numbers 

Let's say that we have a database of 50 drawings and that the numbers 10 and 20 were drawn 15 and 12 
times respectively in the last 50 drawings in the following manner.  

 

#10:  1,3,5,2,1,4,5,2,3,4,3,5,2,3,4.   
#20:  3,1,4,5,3,6,7,4,6,7,4,3 
These numbers mean that number 10 was drawn on the first drawing and then 3 drawings later and then 
5 drawings later and so on.  Number 20 was drawn on the third drawing and then 1 drawing later and 
then 4 drawings later and so on.  
 
We see that the periodic pattern of number 10 is 5,2 because number 10 was drawn 3 times in the order 
of 5,2.  The periodic pattern of number 20 is 6,7 because number 20 was drawn 2 times in the order of 
6,7.  In other words if number 10 is drawn and it’s current periodic frequency is 5, then it has a tendency 
to show up 2 draws later and if number 20 is drawn and it’s current periodic frequency is 6, then it has a 
tendency to show up 7 draws later.   
 
Because of the above-mentioned reason, numbers 10 and 20 would appear on the Top Periodic Pattern 
graph.  Provided that the frequency of the pattern of numbers 10 and 20, which are 3 and 2 respectively, 
are among the Top pattern frequencies. 

 


